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1. Introduction
DBA/Query is a set of tools for manipulating data and for quickly finding
and displaying the information needed from ALLBASE/SQL and
IMAGE/SQL databases.  Although DBA/Query uses Structured Query
Language (SQL), no expert knowledge of it is necessary.

DBA/Query has two active software programs.  The client runs on a
standard personal computer (PC). The server operates on the HP system
containing the databases.  In an operational system, one client can
communicate with one or multiple servers.  The client communicates with
the server using DBA/Query’s built in communications.  DBA/Query can
connect to database machines over a local area network (LAN) or a wide
area network (WAN).  It includes its own communications facilities that can
co-exist and are compatible with most LAN operating systems.   No external
add-on communications or terminal emulators are required.

The client PC operates under Microsoft Windows.  Like most Windows
applications, DBA/Query is easily used with a mouse.  It provides the
customary screen objects menu, toolbar, push buttons, list boxes, scrolling
regions that make the user interface simple.  All operations are prompted
on the screen.  Complete online help is always available at the touch of a
key or a click of a mouse.

The operations supported by DBA/Query are:

•••• Query Retrieve data from multiple tables and view in the 
desired order and grouping.

•••• Insert Add rows of data to any table in the  database.

•••• Delete Delete selected rows from any table.

•••• Update Modify data in selected rows from any table.

The Quick Start section of this manual briefly summarizes the steps taken to
accomplish each of the listed operations.  Subsequent sections describe each
of the operations in detail and provide installation instructions for both the
server and the client modules of DBA/Query.
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connect to host

select a database

formulate a query

insert rows
delete rows

update data

query in freeform

2. Quick Start
This section briefly outlines the steps required to perform each of the five
DBA/Query operations: formulating a query, directly writing a free form
query, inserting new rows into a table, deleting rows and updating data.

Start DBA/Query by double clicking on its icon in the Windows Program
Manager.  The main window appears.  This window offers both a menu and
a toolbar.  The menu includes the toolbar functions and other commands.
The menu and toolbar may change depending on the operation selected.

Figure 2-1. DBA/Query Main Window

To quit DBA/Query at any point, choose Exit from the File menu.  If more
information is wanted about a particular dialog or option, press the F1 key
or select Help from the menu.  This brings the online help system directly
to information pertinent to the current action.

Preparation
Before performing any database operations,
connection must first be made to the host server.
In the window, identify the host by name or IP
address.  Log on with a User and Account that
has authority to access the desired databases.  If
Group is left blank, the default group is assumed.

Should the connection operation fail, check the network setup.

Click
(or select Connect
from the File menu) to
activate the Server
Connection window.

Menu

Toolbar
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save query results

print query results

run query

query analyzer

select sources

define output

selection criteria

indicate order

define grouping

having clause

Next, open the databases that are going to be
worked with and select one, making it active.

Enter the database name in the window and click
on [Open DB].  As the databases are opened,

they are added to the opened list below. Make one active by double clicking
on it or by highlighting it and clicking on the [Select] button.

Formulating a Query
When Query is selected, a number of functions
are added to the menu and toolbar.

The [Run] button allows execution of the query.
The buttons to the right, starting with [Table]
and ending with [Having] opens windows

related to the particular function.

Figure 2-2. Query Toolbar

This window allows identification of source
tables/views.  Indicate the type of source to
access by checking Table and/or View.  Display
a list of possible source tables and/or views by
clicking on the [List] button.  If the scope is not
narrowed by entering an owner or table/view

name, all tables/views in the database appear in the list.

Select the sources to be included, one at a time.  With each additional table
added, a prompt asking for a join condition will appear.  Select the table
that has a matching column and then select the respective column names

Click
(or select Database
from the File menu) to
activate the Open
Database window.

Click
(or select Query  from
the Functions menu)
to activate the Query
window,  which dis-
plays the particulars of
the  SQL statement.

Click
(or select Table from
the Query menu) to
activate the table
selection window.
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from the drop down lists.  Click on [OK] when done and the selected tables
will be listed in the Query window.

This window lists all of the columns in the tables
and views that have been selected.  Highlight
each column that is to be included and click on
[Select].  The asterisk (*) can be selected to
include all columns in the table.

In the selected column list, highlighting a column to move and clicking on
the up or down arrow buttons can reorder the columns.  After clicking on
[OK], the selected columns appear in the Query window.

Use the Select tool to specify criteria that rows
must possess in order to be included in the
query.  For convenience, the window gives a
drop down list of columns and a drop down list
of relational and logical operators.  The editing
region is in free format, which means the

program does not check syntax.  Constructing a proper query clause is
dependent on personal choice.  Parentheses must be provided to resolve
ambiguity.

The Order tool sorts out data for the query.  It
selects sort column(s) from the list of columns
included in the query.  Order the selected
column(s) with the primary sort column at the
top.  After clicking on [OK], the sort columns
appear in the Query window.

The Group tool selects the column(s) by which
to group the query results.  Order the selected
columns with the major grouping at the top.
Click on [OK] to return to the Query window.

The Having tool provides selection criteria for
the specified data groups.  This window looks
and acts like the Select By window.  Construct
the clause in a logical way and click on [OK]
when done.

Click
(or select Output from
the Query menu) to
activate the output
selection window.

Click
(or choose Select
Condition from the
Query menu) to
activate the Select
Condition window.

Click
(or select Order By
from the Query menu)
to activate the window.

Click
(or select Group By
from the Query menu)
to activate the window.

Click
(or select Having from
the Query menu) to
activate this optional
window.
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The Query window now shows all the components of the parameters set
forth.  The query can be saved so that it can be run anytime and it can be
executed immediately.

When the query successfully concludes, a
window displays the number of rows that
qualified and prompts for entering of the number
of rows to be downloaded to the PC.

If there are any problems with the query statement, the error message will
be passed through to an alert window.  The error can be corrected and the
query can be rerun.

The resulting rows are displayed in spreadsheet format of 60 row
increments.  The ramifications of the paging feature on printing or copying
query results are discussed in the Query chapter.

It might be easier to view data in vertical mode.
To view the previous or next row, click on
[Prev] or on [Next].  Click on [OK] when done
to return to the Query Data window.

Query results can be saved as a tab-delimited
ASCII file to be imported into other applications,
such as a spreadsheet or word processor.  The
query can be saved as a file to be executed again

at another time.  Select Save As from the File menu and give the query file
a name.  The file extension defaults to .QRY.

Query results can be printed at any time.  Select
any or all of the query output.  Constructed .SQL
or .QRY files can also be printed.  The output
appears in free form query, with query

statements appearing in the left column.

Click
(or select Run from
the Query menu) to
execute the query.

Click
(or select Vertical
from the Insert menu)
to switch display
mode.

Click
(or click Description
from the Query menu)
to save.

Click
(or select Print from
the File menu) to print.
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As an advanced database user who has a
working knowledge of access plans, this feature
allows optimization of data selection.  Indexes
and constraints can be analyzed.  Table
information can also be viewed.

The query builder does not have to be used to
construct queries.  Queries can be constructed
directly by typing SQL statements and their
predicates.

Inserting New Rows
The Table Select window appears first when the
Insert operation is selected.

1. Select the target table by double clicking on
a table in the list of tables in the database.

2. The Insert Data window shows all columns
in the table in spreadsheet format.  Data
values can be entered into the spreadsheet or
when in vertical mode.  In vertical mode,
column attributes are shown with each data
entry field.  Only one row at a time can be
entered in vertical mode.

3. Click on [Insert] to execute the operation.

Column validation is performed when the Insert statement is executed.  An error
aborts the insert operation beyond the error point.  That is, all rows up to the row in
error are successfully inserted; none beyond the error point are inserted. The error
will need to be corrected and the Insert statement must be run again.

Deleting Rows
The Table Select window appears first when the
Delete operation is selected.

1. Select the target table by double clicking on
a table in the list of tables in the database.

2. In the Delete Data window, retrieve the
rows to be deleted.  To enter selection

Click
(or select Query
Analyzer from the
Query menu) to
analyze a SQL
statement.

Click
(or select Query in
Freeform from the
Functions menu) to
construct queries.

Click
(or select Insert from
the Functions menu)
to activate the insert
data operations.

Click
(or select Delete from
the Functions menu)
to activate the row
deletion operations.

Click
(or select Vertical
from the Insert menu)
to switch display
mode.
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criteria, double click on a column name to
copy the name into the selection criteria
editing region.  Then, enter a valid relational
operator and the data value.  The selection
expression can be as complex as desired, but
it must be logical.  Click on [Search] to
display the selected rows in the spreadsheet.

3. Place a check mark beside each row to be
deleted.  Toggle the check mark by clicking
on the button to the left of the spreadsheet
row.

4. When the rows to be deleted have all been
checked, click on [Delete] to execute the
operation.

Updating Data
The Table Select window appears first when the
Update operation is selected.

1. Select the target table by double clicking on
a table in the list of tables in the database.

2. In the Update Data window, retrieve the
rows to update.  To enter selection criteria,
double click on a column name to copy the
name into the selection criteria editing
region.  Then, enter a relational operator and
the data value.  The selection expression can
be as complex as desired, but it must be
logical.  Click on [Search] to display the
selected rows in the spreadsheet.

3. The retrieved rows are presented in
spreadsheet format.  Data values can be
entered into the spreadsheet or switched to
vertical mode.  In vertical mode, column
attributes are shown with each data edit
field.  Only one row at a time can be edited
in vertical mode.

4. Place a check mark beside each row to be

Click
(or select Update from
the Functions menu)
to activate the update
data  operations.
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updated.  Toggle the check mark by clicking
on the button to the left of the spreadsheet
row.

5. When the rows to be updated have all been
checked, click on [Update] to execute the
operation.

Security Configuration
The network administrator grants certain privileges, such as being able to
insert, delete, or update data.  Select File and then Preferences from the
menu to determine privileges.  Scroll through the preferences in the left
column.

Personal configurations can also be set.  For example, when starting
DBA/Query for Windows, it can automatically log on to the server and
open a database.
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3. Preparation
Before performing any of the DBA/Query functions, connection must first
be made to the server machine where the target database resides.  Then the
database must be opened.  The server module must be running on the server.
See the Installation section for guidance in starting the server module.

Connecting to the Host
In the “Server Connection window,” in the Host
field, either enter the name of the host server
(e.g. LT) or the IP address in dot notation
(e.g.192.70.217.2).

Figure 3-1. Switching Logon with the Server Connect Window

Enter the logon information to access the desired databases.  The User and
Account fields are required.  If the Group field is omitted, the default group
is assumed.  Enter whatever passwords are necessary.  As a password is
typed in, an asterisk is displayed instead of the character typed.

Click on [Connect] or press the Enter key to initiate the network
connection.  An error message appears if the connection attempt fails.  The
error message will tell whether the problem is related to the logon or a
network problem.  If there is a network problem, check the network
configuration on the PC or consult a network manager.

Click
(or select Connect
from the File menu) to
activate the Server
Connection window.
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Upon successful connection, the Server Connect window disappears and the
mouse pointer changes from the hourglass to an arrow.

Opening the Database
The next step is to open the databases with which
to work with and select one, making it the active
database.

The Database Selection window appears with the
server name referenced.  Enter a database name
in the Database Name field and indicate

the access mode.  To have exclusive use of the database, click on [Single].
Click on [Open] to open the database and see it listed in the list below.

Figure 3-2. The Database Selection Window Displaying No Active
Database

Up to 10 databases can be opened in this manner.  From the list of
databases, select one to make active.  Either double click on a listed
database or highlight the database name and click on [Select].  The word
“active” appears in the selected database Status column.  This window
disappears and proceeds with selecting a function from the toolbar or
Function menu.  Otherwise, click on [Close] when done.

Click
(or select Database
from the File menu) to
activate the Open
Database window.
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4. Query
The Query operation provides the tools needed to formulate a
query statement.  A query statement allows retrieval of specific
data elements in a desired arrangement.  This operation leads

through the specification of the various query statement components:

data sources

output columns

selection criteria

row sorting order

data grouping

group selection criteria

Select this operation by clicking on the Query toolbar icon or by selecting
Query from the Function menu.  An alert window comes up if no
connection has been made to the host server and no database has been
selected.

The menu changes to include the Query and Window options while the
toolbar adds more icons.  The Query window is originally empty, however,
the various areas fill in as each statement component is constructed.  A new
query can be created or a previously saved query can be opened.
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Figure 4-1. The Query Window After Constructing a New Query

Because several windows can be opened concurrently while constructing a
query, the Window menu is useful for switching among them.

Creating a New Query
Once connection with a source has been made, a query can be created.  The
operation is performed by clicking on the Query icon.  This causes other
icons to be added to the toolbar.  Select the icons to build a desired query.

Identifying Source Tables
The blank Table window provides an area for
identifying selected tables and a region that
shows their join conditions.

Click
(or select Table from
the Query menu) to
activate the table
selection window.
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Figure 4-2. The Table Window Showing the Two-Table Join

Click on [Add] to select a data source using the Table/View Selection
window.  In the Table/View Selection window, click on [Table] and/or
[View] to check mark the source type.  When [List] is clicked on, all tables
and/or views are listed in the Table list, unless a restriction of the table list is
made.  This is done by specifying an Owner or a specific Table name.

Figure 4-3. The Table/View Window Showing All Tables in the
Database
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Joining Tables
Select a data source, either by double clicking on a row in the Table List, or
highlighting a row and clicking on [Select].  If this is not the first table
selected, the Table Join window appears.

Figure 4-4. The Table Join Window Showing the Link Between Two
Tables

The join condition specifies fields that link the tables.  If more than one
table in a query is included, a join condition should be specified for every
table after the first.  If no join condition is specified, every record in the first
table is joined with every record in the second table as long as the selection
conditions are met.  Such a query can produce lengthy results.

The name of the table just selected is displayed on the left in the Table Join
window.  The Join to Table field gives a selection list of the tables
previously selected.  Select a table from the list and select the respective
columns they have in common.  Click on [OK] to return to the Table
window, where the join condition expression is displayed.

The process can be repeated to join another table or view by clicking on
[Add] again in the Table window.  The [Delete] button removes the selected
table or view from the Selected Tables list.  To remove a join condition,
select it in the list and click on [Remove].  To establish a join condition that
has not already been established, click on [Join] to access the Table Join
window.

After selecting source tables and/or views, click on [OK] to return to the
Query window.  The Query window now displays the list of sources in the
Selected Tables region.  However, the Selected Tables region does not



Query

LeeTech Software Inc. Providing an Alias Name for �a Table Selection 4-5

display join conditions.  Join conditions can only be viewed in the Table
window.

Providing an Alias Name for a Table Selection
If a table that has already been selected for output is desired to be selected,
an alias name must be provided for subsequent selections.  Follow the above
steps for selecting a table.

Figure 4-5. The Table Alias Name Window Indicating that the Same
Table was Already Selected

Type an alias name in the Alias Name field, and click on [OK].

Identifying Output Columns
This identifies the output columns.  The Column
list in the Output Field Selection window shows
all the columns for the listed table in the Table
field.  Select a table name from the Table field.

Click
(or select Output from
the Query menu) to
activate the output
selection window.
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Figure 4-6. The Output Field Selection Window Completed for a Query

Move an individual column to the Output Field List by either double
clicking on an element in the row or highlighting an element and clicking on
[Select].  A block move can be done by holding down the active mouse key
and dragging the pointer to the row at the other border of the block.  Click
on [Select] to copy all the highlighted columns to the Output Field List.

The first column listed for each source in the Column List is an asterisk (*).
Choosing this entry includes all the columns in the table.  If the asterisk is
selected, do not include any of the other columns in that source.

To add an expression as the output field, click on [Add Exp.] to open the
Expression window.  The expression is typed or “assembled” in the editing
field Expression.  A column name in the Column selection list can be
clicked on to insert it into the expression.  Notice, in the Output Field List,
only (Expression...) can be seen under the Column list.  Once the expression
in the Output Field List has been placed in the Query window, as explained
below, the expression’s contents can then be seen.  Use the Table selection
list to access column names in the various joined tables.
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Figure 4-7. The Expression Window Showing a Simple Expression

In addition, for convenience, relational operators and notation symbols can
be inserted by clicking an element in the Operator selection list.  Aggregate
functions are provided in the Function list.

After all the output columns are identified, they can be can re-sorted into a
preferred order.  Highlight a row and use the up and down arrow buttons to
move the row.  Only the highlighted row and the row selected with the
arrow button are re-sorted.  Highlighting the list row and clicking on
[Remove] can eliminate individual output columns.  To clear the Output
Field List and start over, click on [Remove All].  The [OK] button
concludes this transaction, and returns to the Query window, where the
selected columns are displayed in the Output Field List.

Specifying Query Selection Criteria
A selection condition can be constructed that becomes part of the query
statement along with the join conditions.  The selection condition specifies
the criteria that rows must meet to be included in the query results.  It must
be a logical expression.  A query can include as many selection conditions
as desired, which all need to be connected with the AND/OR operator.  The
NOT operator cannot be used to reverse the value of a logical expression.
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The Column field provides a drop down
selection list of all the fields in the table
currently in the Table field.  Change tables by
selecting another from the drop down selection
list.  The Operator field is a drop down selection
list of permitted relational operators.

Figure 4-8. The Select Condition Window Showing a Simple Expression

Type the expression into the scrollable editing region.  A column name can
be popped in at the insertion point by selecting it from the Column drop
down list.  Likewise, an operator can be inserted.  The expression must
abide by logical rules.  Any parentheses needed to resolve ambiguity must
be provided.  Click on [OK] to return to the Query window, where the
selection condition is displayed.  [Cancel] returns to the Query window with
no select condition displayed.

Specifying Output Sorting Sequence
This sorts the rows in the query result.  The
Order By Selection window displays a list of the
output columns and their attributes.  Move an
individual column from the Column List to the
Order By List either by double clicking on an
element in the row or by highlighting an element
and clicking on [Order].

Click
(or select Order By
from the Query menu)
to activate the window.

Click
(or choose Select
Condition from the
Query menu) to
activate the Select
Condition window.
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Figure 4-9. The Order By Window

After all the sort columns have been chosen, they can be reorganized.
Highlight a row and use the up and down arrow buttons to move the row to
the desired position in the sort order.  The default sort order is ascending
(ASC); however, the order can be altered to be descending (DESC), by
highlighting the column and clicking on [Asc/Desc].

To remove a selected column, highlight an element in the Order By window
and click on [Remove].  To clear the entire Order By List and start over
click on [Remove All].  Click on the [OK] button to return to the Query
window, where the selected columns are displayed in the Order By region.
Click on the [Cancel] button to return to the Query window without
selecting any columns.

Identifying Query Output Grouping Specification
This groups rows in the query based on values in
one or more columns.  The Group By clause
defines how to group the query before
performing an aggregate function in the Output
Field List.  The rows that satisfy the expressions

in the Select Condition window are grouped.  Therefore, all values in the
Output Field List that are not aggregate functions must be selected.

Click
(or select Group By
from the Query menu)
to activate the  dialog
window.
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Figure 4-10. The Group By Window

The Group By window displays a selection list of columns and their
attributes.  The columns listed are those contained in the table indicated in
the Table field.  To switch to another table, select it from the table list that
drops down when clicking on the arrow on the right.

Move an individual column to the Group By List by either double clicking
on an element in the row or by highlighting an element and clicking on
[Group].  After moving the columns to the Group By List, which
determines how to group the query rows, re-organize them with the major
group column at the top.  Highlight a row and use the up and down arrow
buttons to move the row to the desired position in the sort order.
Highlighting the list row and clicking on [Remove] can eliminate a column.
To clear the Group By List and start over, click on [Remove All].  Click on
the [OK] button to return to the Query window, where the selected columns
are displayed in the Group By region.  Click on the [Cancel] button to
return to the Query window without selecting any columns.



Query

LeeTech Software Inc. Identifying Group Selection Criteria 4-�11

Identifying Group Selection Criteria
The criteria that groups, as chosen above with the Group By statement, must
meet to be included in the query result, can be specified. Having condition
are a subset of the Group By conditions.  Therefore, a Having conditions
without a Group By condition is ignored.  Also, expressions in the Having
window are more specific than expressions in the Select Condition window.
This is because the Select Condition expressions are evaluated first.  Then
Group By expressions are evaluated within the Select Condition constraints.
The Having clause can include as many selection conditions as desired,
though it must be connected with the AND/OR operator.

This opens the Having window.  The Column
field provides a drop down selection list of the
table columns indicated in the Table field.  The
Operator field is a drop down selection list of
permitted relational operators.

Figure 4-11. The Having Window Showing a Simple Expression

Type the expression into the scrollable editing region.  A column name can
be inserted at the insertion point by selecting it from the Column drop down
list.  Likewise, an operator can be inserted from the Operator drop down list.
The expression must abide by logical rules.  Any parentheses needed to
resolve ambiguity must be provided.  Click on [OK] when done to return to
the Query window, where the Having condition is displayed.

Click
(or select Having from
the Query menu) to
activate this optional
window.
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Executing a Query
This executes the query.  In the Data Transfer
window, click on [Count] to find the number of
rows that are returned when the query is
executed.  If not all rows are wanted to be

retrieved, click on the Select radio button, and enter the number of rows that
are desired in the field box.  Otherwise, Click on the [All] radio button to
transfer all rows resulting from the query.  At any time, the query can be
run, its results can be observed and the selection criteria can be refined.

Figure 4-12. The Data Transfer Window Indicates the Number of Rows
to Transfer

If the query fails because of access or syntax error, an error message pops
up.  The error code is included so the problem can be researched, if
necessary, in the appropriate reference manual.  Correct the query and run it
again.

A successful query returns a Query Data window and displays the results in
the status bar.  The menu changes to include the Edit option, while the
Query option is removed.

Click
(or select Run from
the Query menu) to
execute the query.
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Figure 4-13. The Query Data Window Displaying Rows Retrieved

The Query Data window shows the data in spreadsheet format.  Not only
does the spreadsheet scroll, but the cell size can be adjusted to
accommodate varying data value size.  Drag the boundary between row
numbers down to make the row higher, allowing data to wrap.  Drag the
boundary between column names to shrink or expand columns horizontally.

Viewing Query Output in Vertical Mode
It might be easier to view data in vertical mode.
Click on the Vertical icon in the toolbar (or
select Vertical from the menu) to open the
Vertical Data window.  In this window, the
Column Names from the Query Data window are
displayed in the first column.  The Values for
each row in the Query Data window are

displayed in the second column.  To view the previous or next row, click on
[Prev] or [Next].  Click on [OK] when done to return to the Query Data
window.

Click
(or select Vertical
from the Insert menu)
to open the Vertical
Data window and
switch the display
mode.
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Figure 4-14. Data Shown in the Vertical Data View Window

A block of cells can be highlighted and copied to the Windows clipboard by
selecting Copy from the Edit menu.  From the clipboard, the data can be
pasted into another Windows application.

The results can be printed in spreadsheet format by selecting Print from the
File menu.

Query result rows are downloaded to the PC in 60-row increments.  This
feature is not apparent when scrolling through the rows.  It does have
implications, however, when copying rows to the clipboard.  No matter what
rows are highlighted, only the rows from the current page that are part of the
60-row increment are selected.  Thus when rows that are not from the same
60-row increment are selected, only the rows of the page currently in use are
selected.  For example, if rows 40 through 80 are highlighted, only rows 40
to 60 will show up if the current page increment begins at 1.  Rows 61
through 80 are retrieved if the current page increment starts at 61.

However, to transport all query results to another application, save the data
to a file.  With the Query Data window active, select Save as from the File
menu.  The standard Windows Save File dialog window opens.  A drive
letter and directory can be selected and then a file name of no more than 8
characters can be entered.  The file extension .TXT is assigned if no
extension is provided.  All data from the Query Data window is written into
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a tab delimited ASCII text file.  Each row terminates with a carriage return, line feed.
Numerous applications recognize this format.

Save a Query
The query, itself, can be saved to a file.  This
way it can be used again or as a template for
other queries.

Figure 4-15. The Standard Windows Save As Dialog Window

The standard Windows Save As window permits changing of the drive letter
and directory.  Enter up to eight characters as a name for the query file.  The
file extension of .QRY is automatically assigned if no extension is entered.
Click on [OK] to save, and return to the Query window.

It might be useful to document the query before saving it.  Thus when the
query is run at a later date, the query’s purpose and characteristics can be
remembered by reading the associated description.  Select Description from
the Query menu to open an editing window.  If the query has not been
previously documented, then this window is empty.  Type comments and
click on [OK] to return to the Query window.  Otherwise, if someone has
already documented this query, see the comments in the window.  More
comments can be typed or the existing comments can be changed.

Analyzing a Query’s Performance
As an advanced database user who has a working knowledge of access
plans, this feature allows optimization of data selection.  When a query is
executed, the optimizer, which is a built-in program, usually generates the

Click
(or click Description
from the Query menu)
to save.
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table statistics

index constraint

most efficient path to the desired data.  However, the optimizer might not
always generate the most efficient path for a query.  If the search is through
many large tables with many specific clauses, for example, there might be a
more efficient searching method.

This enters the Query Analyzer mode.  The menu
and toolbar change to the following:

Figure 4-16. Query Analyzer Mode Screen

Performance Impact by Index
If the query does any index sorting.  The
following screen appears:

Figure 4-17. The Table Index Window

Click
(or select Query
Analyzer from the
Query menu) to
analyze a SQL
statement.

Menu

Toolbar

Click
(or select Index Info
from the View menu)
to sort.
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The index names are listed in the Indexes field.  Double click on an index
name, and the attributes are shown in the fields to the right, as well as which
column name.  From here, it can be determined whether the query is
executing most efficiently, for example, whether the index scan is used.

Performance Impact by Table
This allow viewing of general table statistics,
such as the number of rows.  The following
screen appears:

Figure 4-18. The Table Information Window (A Read-Only Window)

This screen also displays the number of constraints and indexes.  This is a
good screen to view constraints and indexes are being analyzed.

Performance Impact by Constraint
The constraints screen allows viewing of the
different types of table or column constraints that
are present.  The following screen appears:

Click
(or select Constraint
Info from the View
menu) to view
constraints.

Click
(or select Table Info
from the View menu)
to view statistics.
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Figure 4-19. The Table Constraints Window

The constraint names are listed in the Constraints field.  Double click on a
constraint name, and the attributes are shown.

Creating a Query in Free Form
This allows direct writing of SQL queries, if it is
more familiar and the query builder is not
desired to be used.  The Query in Free Form
window is displayed.

Click
(or select Query in
Freeform from the
Functions menu) to
construct queries.
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Figure 4-20. DBA/Query in a Free Form Window with a Written Query

Select Edit from the menu to cut, copy, paste, or delete any text.  Copying
can be made to the clipboard and to or from other Windows documents.

Table Name Lookup in Free Form Mode
This allows searching for a particular table.

Figure 4-21. The Table Search Window

After clicking on [Search], the Table name appears in the Table field in the
Query in Free Form window.

Click
(or select Table
Search from the
Query menu) to search
for a table.
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Save a Query while in Free Form Mode
Also, queries that have been constructed with the query builder can be
saved.  To do this, have the Query window open with the file that is to be
converted.  Select File, Save As from the menu.

Figure 4-22. The Query Save Options Window Allows Saving in Two
Formats at Once

Select SQL Text Format (*.sql), which is highlighted by a red checkmark.
The query is saved as a .SQL file.

Note: When printing a .SQL file, the output consists of SQL statements and
their predicates.  The printed output appears in a linear format, with each
SQL statement neatly arranged in the left column, followed by each of its
predicates.

Printing
In the Query mode, four different windows can be printed from:

• Query

• Query Analyzer

• Query Data

• Query in Free Form

Each of these windows prints different results.

Query
When printing a query, the output is printed in SQL format, with each SQL
statement in the left column.
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Query Analyzer
When printing from the Query Analyzer, there is an option to choose
whether to print from the memory buffer, the screen or a selection.  Select
from these by highlighting the proper radio button.

Figure 4-23. The Print Window Possessing Different Options

Query Data
When printing query data, the same options for printing from the Query
Analyzer can be chosen.

Query in Free Form
When printing a free form query, the output is printed in the same format as
query data.

Opening a Saved Query
To open a previously saved query, select Open Query from the File menu.
The standard Windows dialog window lists all files in the default directory
that have the extension .QRY, and .SQL for those who have designed free
form SQL queries.  The drive letter directory can be changed as needed.
Double click on the query file name or highlight the file name and click on
[OK].

The Query window opens, displaying the SELECT statement components.
The menu and toolbar change as they did when creating a query.  Any of the
components can be modified before running the query by selecting any of
the query tool icons or menu options.  The associated dialog window
contains the existing specifications.  A modified query can also be saved.
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5. Insert
The Insert operation adds new rows into the
selected table.  If no connection has been made
to the host server and the database has not been
opened before, a popup window informs of this.

Selecting Tables
The Table Selection window prompts selection of the target table.  An
owner or a specific table name can be entered before generating the list of
tables by clicking on [List].

Figure 5-1. The Table Selection Window Listing All Database Tables

Select the desired table by either double clicking an element in its row or
highlighting an element and clicking on [Select].  Edit and Insert options
are added to the menu.  The Run and Vertical icons, which are added to the
toolbar, are also available by selecting Insert from the menu.  The Insert
Data window appears, displaying an empty spreadsheet.

Inserting Data
Data can be entered directly into the scrolling spreadsheet.  An entered data
value scrolls within the cell, if necessary.  However, by adjusting the cell
height, entered text wraps.  The height of a row can be adjusted by
positioning the mouse pointer on the boundary between row numbers,
holding down the active mouse button and dragging it vertically to the

Click
(or select Insert from
the Function menu) to
activate the insert data
operation.
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desired height.  Likewise, the width of a column can be adjusted by
positioning the mouse pointer on the boundary between column names and
dragging it horizontally to the desired width.

Figure 5-2. The Insert Data Window

It may be easier to insert data in vertical mode.
Each row of this spreadsheet gives the column
name and attributes in the table.  The rightmost
field is for entering data.  One table row can be
entered at a time in the Vertical Data Insert
window.

Figure 5-3. The Vertical Data Insert Window for Entering a Single
Row

Click
(or select Vertical
from the Insert menu)
to activate the Vertical
Data Insert window.
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In either the default spreadsheet or vertical mode, the Cut and Copy options
on the Edit menu can be used to move or duplicate data from one cell or a
group of cells to another.  Either option transfers the highlighted data to the
Windows clipboard.  Then Paste can be selected to transfer the selected data
back to the spreadsheet.  The Edit menu also provides the option to remove
the row that is highlighted (that is, the row with the active cell) with Delete
Row.  The Insert Row option inserts a blank row above the highlighted row.
To view the previous or next row, click on [Prev] or [Next].  Click on [OK]
when done to return to the Insert Data window.

Executing
When done entering data, the insertion process
can be executed.  An error in any row aborts the
insertion process.  All rows preceding the row in
error are successfully inserted.  The Insert Data
spreadsheet displays only the rows that are not

inserted.  The row in error is the first row shown.  Correct the field(s) in
error and the insertion process can be run again.

Click
(or select Run from
the Insert menu) to
execute the insertion
process.
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6. Delete
The Delete operation retrieves the rows specified
from the selected table, allows confirmation of
their deletion and then deletes them from the
table.  If no connection to the host server has
been made and a database has not been opened,

a popup window informs of this.

Selecting Tables
The Table Selection window prompts selection of the target table.  An
owner or a specific table name can be entered before generating the list of
tables by clicking on [List].

Figure 6-1. The Table Selection Window Listing All Database Tables

Select the desired table by either double clicking an element in its row or
highlighting an element, and click on [Select].  The Delete Data window
appears, presenting an empty spreadsheet and an editing region to use for
constructing selection criteria for data retrieval.

Deleting Data
The opened database and selected table are identified at the top of the
Delete Data window.  The Column List includes the names of all columns in
the table.  The Search Condition editing region allows entering of an

Click
(or select Delete from
the Function menu) to
activate the delete
operation.
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optional logical expression, which is used as the selection criterion for data
retrieval.  For convenience, a column name can be copied into the
expression, at the insertion point, by clicking the column name in the
Column List.  The expression must abide by the SQL rules set forth in the
database reference manual.  Compound expressions must be connected with
the AND or OR operator.  Any parentheses needed to resolve ambiguity
must be provided.  Click on [Search] when ready to retrieve data.

Figure 6-2. The Delete Data Window with Retrieved Rows

Viewing in Vertical Mode
It might be easier to view data in vertical mode.  Click on the [Vertical]
button in the Delete Data window Vertical Data View window.  Each row of
this spreadsheet gives the column name and attributes of a column in the
table. To view the previous or next row, click on [Prev] or on [Next].  Click
on [OK] when done to return to the Delete Data window.
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Figure 6-3. The Vertical Data View Window Allows Viewing of the
Rows

Searching for Rows
The Delete Data Search window displays how many rows have been
selected and prompts for response of the number of rows to download.  A
maximum of 100 rows can be downloaded.

Figure 6-4. The Delete Data Search Window Gives the Number of Rows
Found

The downloaded rows are locked for deletion while they are owned.  A
timer starts as soon as the rows are downloaded.  The system administrator
sets this timer, mostly for system performance.  See the System
Configuration chapter for more information on the timer, or consult a
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system administrator.  When the timer expires, a warning message appears
stating “You have locked the transaction for x seconds.  Do you want to
continue?”  Click on [Yes] to reset the timer and continue.  Click on [No] to
terminate the operation.  If there is no response in x seconds, the operation
is automatically terminated and the row locks are released.

Executing
The downloaded rows are displayed in the spreadsheet region of the Delete
Data window, for review.  Data values scroll within their cells, as necessary.
Each row must be check marked for it to be deleted.  The button to the left
of each row is the check mark toggle.  Click it to mark the row.  Click on
[Select All] to check mark all the rows.  Click on [Unsel All] to remove all
the check marks.  All of the rows in the Delete Data screen, above, have
been checked for deletion.  A row will not be deleted unless it is checked.

When done check marking the rows, execute the deletion process by
clicking on the [Delete] button in the window.  The [Cancel] button
terminates this operation with no rows deleted.  Either action releases the
row locks.
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7. Update
The Update operation retrieves the rows
specified from the selected table, allows
modification of the data and then updates the
table.  If no connection to the host server has
been made and a database has not been opened,

a popup window informs of this.

Selecting Tables
The Table Selection window prompts for the selection of a target table.  An
owner or a specific table name can be entered or clicking on [List] can
generate a list of tables.

Figure 7-1. The Table Selection Window Listing All Database Tables

Select the desired table by either double clicking on an element in its row or
highlighting an element and clicking on [Select].  Edit and Update options
are added to the menu.  The Run and Vertical icons, which are added to the
toolbar, are also available by selecting Update from the menu.  The Update
Data window appears, displaying an empty spreadsheet and an editing
region to construct selection criteria for data retrieval.

Click
(or select Update from
the Function menu) to
activate the update
operation.
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Updating Data
The opened database and selected table are identified at the top of the
window.  The Column List includes the names of all columns in the table.
The Search Condition editing region allows entering of an optional logical
expression, which is used as the selection criterion for data retrieval.  In
formulating the expression, a column name can be inserted into the
expression by double clicking on the column name in the Column List.  The
expression must abide by SQL rules.  Compound expressions must be
connected with the AND or OR operator.  Any parentheses needed to
resolve ambiguity must be provided.  Click on [Search] when ready to
retrieve the data.

Figure 7-2. The Update Data Window with Retrieved Rows

Updating in Vertical Mode
It might be easier to update data in vertical mode.  Click on the [Vertical]
button in the window to open the Vertical Data Update window.  Each row
of this spreadsheet gives the column name, its attributes and the existing
data value.  The data value can be modified.  Only one table row at a time
can be displayed in the Vertical Data Insert window.  Click on [OK] to save
the changes and return to the Update Data window.  Clicking on [Cancel]
discards the changes.
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Figure 7-3. The Vertical Data Window for Modifying a Single Row

Searching for Rows
The Query result window displays how many rows have been selected and
prompts for the number of rows to be downloaded.  A maximum of 100
rows can be downloaded.

Figure 7-4. The Update Data Search Window Showing the Number of
Found Rows

The downloaded rows are locked for update while they are accessed.  A
timer starts as soon as the rows are downloaded.  The system administrator
sets this timer, mostly for system performance.  See the System
Configuration chapter for more information on the timer, or consult a system
administrator.  When the timer expires, a warning message appears stating
“You have locked the transaction for x seconds.  Do you want to continue?”
Click on [Yes] to reset the timer and continue.  Click on [No] to terminate
the operation.  If no response is made in x seconds, the operation is
automatically terminated, and the row locks are released.
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Executing
The downloaded rows are displayed in the spreadsheet region of the Update
Data window. The data in the scrollable spreadsheet can be modified.  Data
values scroll within their cells, as necessary.  If the cell height is adjusted,
text wraps.  The height of a row of cells can be adjusted by positioning the
mouse pointer on the boundary between row numbers, holding down the
active mouse button and dragging it vertically to the desired height.
Likewise, the width of a column of cells can be adjusted by positioning the
mouse pointer on the boundary between column names and dragging it
horizontally to the desired width.

Before updating the rows, check mark the rows to be updated.  The button
to the left of each  row is a check mark toggle.  Click it to check mark the
row.  Click on [Select All] to check mark all the rows.  Click on [Unsel All]
to remove all the check marks.  Updates will not be performed on a row
unless it is checked.

When done modifying and check marking the rows, execute the update
process by clicking the [Update] button in the window.  An error in a row
aborts the update process.  Rows preceding the one in error are successfully
updated.  The Update Data spreadsheet displays only the rows that were not
updated.  The row in error is the first row shown.  The field(s) in error can
be corrected and the update process can be run again.
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8. Security Configuration
To ensure system security, an administrator grants a variety of privileges.
These privileges depend on which DBA/Query for Windows functions are
needed.  Viewing can be done with privileges the administrator has granted.
Selecting File, then Preferences from the main menu can set personal user
preferences.  The User Configuration window appears.  In the left column,
choose which configuration to view.

There are six:

• Environment

• Login

• Startup

• User

• Tools

• Restrictions

Environment
The Environment screen shows which types of databases that can be
opened, as well as which operating system is currently running.  Only an
administrator can set the databases that can be opened.
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Figure 8-1. The User Configuration Screen Displaying Database
Options for Opening ALLBASE/SQL or IMAGE/SQL Databases

Login
The system can be configured to automatically login to the host system and
open the database to be worked on.  In this screen, type in the appropriate
Connection setting fields and the Database Name.  Click on [Save As...] to
save the settings.

Figure 8-2. The Login Screen Allows Entering Startup Settings

Startup
To initiate these login settings, select the appropriate radio button in On
Startup, when starting DBA/Query for Windows.  Click on [Save As…]  so
that DBA/Query Windows always starts with this setting.
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Figure 8-3. The Startup Screen Showing Startup Settings

User
Personal information can be entered.  Type the appropriate information into
the fields.  When the program is started, this will appear on the opening
screen.

Figure 8-4. The User Screen Showing Name and Company

Tools
This screen displays what database tools are usable.  An administrator sets
these options.  If more tools are needed, contact the administrator.
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Figure 8-5. The Tools Screen Shows which Tools are Usable

Restrictions
This screen displays how long rows are locked while updating or deleting.
The rows are locked so that others cannot update or delete rows
concurrently.  See the Delete and Update chapters for more information.
Only an administrator can change this setting.

Figure 8-6. The Restrictions Screen Shows how Long Rows are Locked
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9. Help
The Help option on the menu gives access to the DBA/Query online help
system.  The help provided is context sensitive and includes hypertext links.
That is, the subject of the text that appears when Help is clicked on pertains
to the current function.  Topic words and phrases are shown in green.  Click
on any green word to access its specific help information.

Use the mouse to resize the help window.  A page of text can scroll in the
window.  Access additional pages by clicking the right and left arrow
buttons below the horizontal menu.

Return to the main index of topics by clicking on the [Contents] button.
Exit the help system by choosing Exit from the File pull-down menu or
clicking on the Control-menu box in the upper left corner.

The horizontal menu showing between the window title and the row of
control buttons is the standard Windows Help menu.  Read general
Windows help information for explanations on how to use the built-in help
system.



Installation

LeeTech Software Inc. Installing the MPE/iX Server 10-1

10. Installation
DBA/Query for Windows is supplied in two parts, a client and a server
component.  The client software is available on 3.5 inch high density floppy
disks or CD-ROMs suitable for installation on a standard PC.  The HP 3000
server software is on 1600 bpi magnetic tape or DAT tape, as ordered.  The
DBA/Query for Windows client and server programs are installed
separately.  The server software generally follows accepted conventions for
HP installations.  The client software follows conventions for Windows
product installations.  Installation programs are provided for convenience.

DBA/Query for Windows is to be installed on a local area network.  It is
based on the protocol TCP/IP and uses Windows SOCKET.  It supports:

Standard TCP/IP and WinSock
APRA Socket
Microsoft LAN Manager TCP/IP and WinSock
Microsoft NT/Server TCP/IP and WinSock
Novell TCP/IP and WinSock
ftp TCP/IP and WinSock
WRQ RNS TCP/IP and WinSock

Installing the Server
Installing on MPE/iX

1. Log on as system manager:
:HELLO DBAINSTL,MANAGER.SYS

2. Identify the tape device:
:FILE T;DEV=TAPE

3. Mount the DBA/Query for Windows tape and place the drive online.

4. Restore the DBA/Query for Windows installation job into PUB.SYS:
:RESTORE *T;DBAINSTL.PUB. SYS;SHOW

5. Insert the System Manager password into the installation batch file
DBAINSTL.PUB.SYS and then stream it:
:STREAM DBAINSTL.PUB.SYS

6. The DBA/Query for Windows installation job builds a new account
called LEETECH and then prompts for the installation tape.  If the tape
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is already mounted, simply place the drive online.  Otherwise, remount
the tape.

7. The DBA/Query for Windows installation job restores the files into
PUB.LEETECH.

8. Purge the batch file DBAINSTL.PUB.SYS upon successful completion
of the installation:
:PURGE DBAINSTL.PUB.SYS

Entering the LeeTech Account
1. LEETECH account access security required:

(R,X:ANY;W,A,L:AC)

2. LEETECH account capability required:
AM,AL,GL,ND,SF,BA,IA,MR,DS,PH,PM

3. PUB.LEETECH group access security required:
(R,X:ANY;W,A,L,S:AC)

4. PUB.LEETECH group capability required:
BA,IA,MR,DS,PH,PM

Starting the MPE/iX Server
Stream this batch file:
:STREAM JLISTNER.PUB.LEETECH

Installing on HP-UX
1.  “Root” authority is necessary to restore the server files with correct

attributes.

2. Mount the DBA/Query for Windows tape and place the drive online.

3. Restore the DBA/Query for Windows files INSTALL and
LEETECH.0:
$tar xvf /dev/rmt/0m (device name)

4. Run INSTALL.  It will create the following directories if they do not
already exist:

$/opt/leetech/bin
$/opt/leetech/lbin
$/opt/leetech/lib
$/opt/leetech/share
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$/opt/leetech/share/include
$/opt/leetech/newconfig
$/etc/opt/leetech
$/var/opt/leetech

5. Delete the files INSTALL and LEETECH.0 upon successful
completion of the DBA/Query for Windows installation:
:rm INSTALL LEETECH.0

The installed files are:

$/opt/leetech/bin/lanutil
$/opt/leetech/bin/ltupgrad
$/opt/leetech/bin/ltvalida
$/opt/leetech/newconfig/DBAQB
$/opt/leetech/lbin/dvqry
$/opt/leetech/lbin/listner
$/etc/opt/leetech/CNTLDBAQ.PUB.LEETECH

Starting the HP-UX Server
The listener is a server daemon that should be launched before any client-
server connection.  To start the listener:

$/opt/leetech/lbin/listner DBA

Monitoring the Connection
On the server side, manage the user connections by running:

MPE/iX - LANUTIL.PUB.LEETECH
HP-UX - /opt/leetech/bin/lanutil

LANUTIL(A.01.00) LeeTech Software Inc. All Rights
Reserved.

Commands:
LIST - shows all connected users.
KILL id - kills the specified user.
STOPALL - terminates listener and all users.
HOST id - sets to new host node name.
APPL id - sets to new application name.
EXIT - ends the LANUTIL.

LANUTIL>>
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Installing the Client
The DBA/Query for Windows client software is a standard .EXE program
that can be executed from the Program Manager in Windows.  Install the
client software on each PC used to access databases.

System Requirements:
IBM or compatible PC
80386 or above
Hard drive with at least 3 megabytes free
VGA or SVGA monitor
Mouse
Windows 95/98/NT

The DBA/Query for Windows Setup Utility provides options for a single PC
installation.  For a single PC installation, DBA/Query for Windows and
accompanying files are copied to the PC’s hard drive and the DBA/Query
for Windows program group is created within Windows.  DBA/Query for
Windows can then be executed at any time from the icon in Program
Manager.

Installing a Single Workstation
1. If not already running, load Windows.

2. Insert the DBA/Query media into the appropriate  drive for installation.

3. Choose File, Run from the Program Manager main menu.

4. Type Setup in the command line text box.
The rest of the steps later

Configuring the LAN
SERVICES file

1. Find the SERVICES file, and insert the line:

DBA 32600/tcp dba
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DBA is the application name or the socket name that is issued by the
sample program.  The “32600/tcp” portion of the entry is the port ID,
which must be identical to the server’s SERVICES file (please see the
host server section of this manual).  It is the common name used to link
the PC client program and the host server program.  The “dba” portion
of the entry is another alias of DBA and 32600/tcp.

2. The SERVICES file on the PC is located in:

Win 95/98 \windows\
Win NT \winnt\system32\drivers\etc\

HOSTS file

3. Find the HOSTS file on the PC and insert the host IP Address and its
alias (node) name.  Use PING.EXE to verify that the host IP Address is
correct.

4. The HOSTS file on the PC is located in:

Win 95/98 \windows\
Win NT \winnt\system32\drivers\etc\

55..  The socket driver must exist.  Make sure the winsock.dll file is
accessible.  It must either be in the \windows directory or in a directory
listed by the path variable.
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11. Customer Support
LeeTech Software Inc. is dedicated to providing the highest quality software
products available.  In addition, LeeTech believes that high quality,
knowledgeable support is an essential element for full utilization of the
supplied products.  LeeTech has thus structured a complete support package
that is available with all supplied products.

All support contracts include telephone or message based support.
LeeTech’s staff is qualified to assist not only with product use, but also with
any database problems customers may have.  If problems prove extensive
and outside the scope of the maintenance contract, LeeTech can still assist
with low cost consulting.

In addition to specific service requests, LeeTech provides users with
periodic newsletters, software bulletins and other materials designed to help
ensure effective use of LeeTech products.  To be placed on the mailing list,
simply send a request to LeeTech.

LeeTech customer service may be contacted by any of the following.

Mail
Please send all inquiries or problems to:

LeeTech Software Inc.
2085 Hamilton Ave., Suite 200
San Jose, CA 95125
U.S.A.

Telephone Support
All LeeTech customers with a current support services contract can contact
LeeTech at the following numbers.

U.S.A. (800) 995-1987
All Other Countries (408) 253-1987
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Fax-Back Service
LeeTech maintains a 24-hour Fax number for customer input.  Questions
regarding support services will receive immediate attention at the beginning
of the following business day.  Responses will be returned by Fax or by the
method designated on the submission.

Fax Number (408) 558-0802

Electronic Messages
Questions or input can be made via electronic mail.

•  Support needs can be mailed to:

support@leetech.com

•  Information inquiries can be mailed to:

info@leetech.com

•  All product and sales needs can be mailed to:

sales@leetech.com
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A
Alias name, 4-5
ALLBASE/SQL, 1-1
ASCII file, 2-4

B
Buttons

connect, 2-1
constraint info, 4-16, 4-17
database, 2-1, 2-2
delete, 2-1, 2-5, 6-1
group, 2-2, 2-3, 4-1, 4-9
having, 2-2, 2-3, 4-1, 4-11
insert, 2-1, 2-5, 5-1
index info, 4-16, 4-19
order, 2-2, 2-3, 4-1, 4-8
output, 2-2, 2-3, 4-1, 4-5
print, 2-2, 2-4, 4-20
query, 2-1, 2-2
query analyzer, 2-2, 2-5, 4-16
query in free form, 2-1, 2-5, 4-18
run, 2-2, 2-4, 4-12, 5-3
save, 2-2, 2-4, 4-15
select, 2-2, 2-3, 4-1
table, 2-2, 4-1, 4-2
table info, 4-16, 4-17
table search, 4-19
update, 2-1, 2-6, 7-1
vertical, 2-4, 2-5, 4-13, 5-2

C
Client,

installation, 10-4
single work station, 10-4

Configuring
LAN, 10-4, 10-5

Connect
button, 2-1

Connection monitoring, 10-2
Connection to host, 2-1, 3-1
Constraint information, 4-16, 4-17, 4-
18
Creating a new query, 4-2

D
Data

deleting, 6-1, 6-2
updating, 2-6

Data grouping, 4-1
Data sources, 4-1
Database

button, 2-1, 2-2
opening, 2-2, 3-2
selecting, 2-1, 2-2

Delete, 1-1, 2-5, 2-6, 6-1, 6-2, 6-3, 6-
4

button, 2-1, 2-5, 6-1
execution, 6-4
row search, 6-3, 6-4
table selection, 6-1
vertical, 6-2, 6-3

E
Electronic message support, 11-2
Environment

security configuration, 8-1, 8-2
Execution

of row deletion, 6-4
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of row insertion, 5-3
of row update, 7-4

F
Fax support, 11-2
Formulating a query, 2-2, 2-3, 2-4, 2-
5
Free form

query, 4-18, 4-19
table name lookup, 4-19
save, 4-20

G
Group, 2-3, 4-9, 4-10

button, 2-2, 2-3, 4-1
Group criteria, 4-1

H
Having, 2-3, 4-11

button, 2-2, 2-3, 4-1
Help, 9-1

online, 2-1, 9-1
HP-UX

server installation, 10-2, 10-3
server starting, 10-3

I
Identifying source tables, 4-2, 4-3
Identifying output columns, 4-5, 4-6,

4-7
IMAGE/SQL, 1-1
Index information, 4-16, 4-17
Information,

index, 4-16
table, 4-16, 4-17
constraint, 4-16, 4-17, 4-18

Insert, 1-1, 2-5, 5-1, 5-2, 5-3
button, 2-1, 2-5
execution, 5-3
table selection, 5-1
vertical, 5-2, 5-3

Installation, 10-1, 10-2, 10-3, 10-4,
10-5
client, 10-4, 10-5
server, 10-1, 10-2, 10-3

HP-UX, 10-2, 10-3
MPE/iX, 10-1, 10-2

J
Joining tables, 4-4, 4-5

L
LAN, 1-1

configuration, 10-4, 10-5
Login

security configuration, 8-2

M
Mail support, 11-1
Menu, 2-1
Monitoring the connection, 10-3
MPE/iX

server installation, 10-1, 10-2
server starting, 10-2

O
Opening a database, 2-2, 3-2
Opening a saved query, 4-21
Order, 2-3, 4-8, 4-9

ascending, 4-9
button, 2-2, 2-3, 4-1
descending, 4-9

Output, 2-3, 4-5, 4-6, 4-7
button, 2-2, 2-3, 4-1

Output columns, 4-1, 4-5, 4-6, 4-7

P
Performance, 4-15, 4-16, 4-17, 4-18

impact, 4-16, 4-17, 4-18
by constraint, 4-17, 4-18
by index, 4-16
by table, 4-17
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Preparation, 2-1
Print, 2-4, 4-20, 4-21

button, 2-2, 2-4, 4-20
query, 4-20
query analyzer, 4-21
query data, 4-21
query in free form, 4-21

Q
Query, 1-1, 4-1, 4-2, 4-3, 4-4, 4-5, 4-
6, 4-7, 4-8, 4-9, 4-10, 4-11, 4-12, 4-
13, 4-14, 4-15, 4-16, 4-17, 4-18, 4-19,
4-20, 4-21

analyzing, 2-5, 4-15, 4-16, 4-17,
4-18
button, 2-1, 2-2
formulating, 2-2
functions, 2-1, 2-2
in SQL, 2-5
new, 4-2
open, 4-21
print, 4-20
running, 2-4, 4-12, 4-13
save, 4-15
vertical, 4-13, 4-14, 4-15

Query analyzer
button, 2-2, 2-5
print, 4-21

Query data
print, 4-21

Query in free form
button, 2-1, 2-5, 4-18, 4-19
print, 4-21

Quickstart, 2-1

R
Restriction

security configuration, 8-4
Row sorting order, 4-1
Rows

deleting, 2-5, 6-1, 6-2, 6-3, 6-4

inserting, 2-5, 5-1, 5-2, 5-3
searching,

for deleting, 6-3, 6-4
for updating, 7-3

updating, 7-1, 7-2, 7-3, 7-4
Run, 2-4, 4-12, 4-13, 5-3

button, 2-2, 2-4, 4-12, 5-3
Running a query, 2-4

S
Save, 2-4, 4-15

button, 2-2, 2-4, 4-15
in free form, 4-20

Saved query
open, 4-21

Search
for rows

for data deletion, 6-3, 6-4
for data update, 7-3

for table, 4-19
button, 4-19

Security configuration, 2-7, 8-1, 8-2,
8-3, 8-4

environment, 8-1, 8-2
login, 8-2
restrictions, 8-4
startup, 8-2, 8-3
tools, 8-3, 8-4
user, 8-3

Select, 2-3, 4-7, 4-8
button, 2-2, 2-3

Selecting tables
for deleting, 6-1
for inserting, 5-1
for updating, 7-1

Selection criteria, 4-1
Server

installation, 10-1, 10-2, 10-3
HP-UX, 10-2, 10-3
MPE/iX, 10-1, 10-2

starting
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HP-UX,  10-3
MPE/iX, 10-2

Single workstation installation, 10-4
Source tables, 4-2, 4-3
SQL format, 4-18, 4-19, 4-20
SQL SELECT Statement, 4-1
SQL syntax, 2-6
Starting the server

HP-UX,  10-3
MPE/iX, 10-2

Startup
security configuration, 8-2, 8-3

Support, 11-1, 11-2
electronic message, 11-2
fax, 11-2
mail, 11-1
telephone, 11-1

T
Table, 2-2, 4-2, 4-3, 4-4, 4-5

alias name, 4-5
button, 2-2, 4-1
information, 4-16, 4-17
joining, 4-4, 4-5
name lookup in free form, 4-19
search, 4-19

button, 4-19
selection

for deleting, 6-1
for inserting, 5-1
for updating, 7-1

Telephone support, 11-1
Toolbar, 2-1
Tools

security configuration, 8-3, 8-4,

U
Update, 1-1, 2-6, 2-7, 7-1, 7-2, 7-3, 7-
4

button, 2-1, 2-6, 7-1
execution, 4-1

row search, 7-3
table selection, 7-1
vertical, 7-2, 7-3

User
security configuration, 8-2

V
Vertical mode, 2-4, 2-5, 4-13, 4-14,
4-15, 5-2, 5-3, 6-2, 6-3, 7-2, 7-3

button, 2-4, 2-5, 4-13, 5-2

W
WAN, 1-1
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